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Abstrakt

Hlavnim cilem této bakalafské prace bylo zpracovat vlastni pohled na vyuzitl
informaénich technologii pii procesu vzdélavani a po té vytvorit multimedidlni vyukovy
kurz v prostiedi LECTURNITY, které mad FM (resp. TU v Liberci) k dispozici.
Zkusenosti s praci v LECTURNITY tvoii podstatnou ¢ast prace. Tato ¢dst by méla
slouZit pro dals{ uZivatele-pedagogy jako pomicka pii tvorbé multimedidlnich lekei.
Dalsim vysledkem mé price je multimedializovany kurz pro vyuku programovaciho
jazyka C.  Vytvofeny kurz ma poslouZit studentim k samostudin, zdkladi

programovani.

The main goal of this work was to show my own opinion on using IT during
educational proces and build a multimedial learning course in an enviroment called
LECTURNITY. Knowledges founded by studying e-learning-problematics are
integrated into this book and they take a big part of it. This part should help
users(teachers) to build their own multimedial courses. The concrete, multimedial
course, that I create, is about programing language C defined with guideline ANSI. This

course can be used by students to teach them basics of programing.
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Uvod

V ramci této price jsem se zabyval problematikou e-learningu. Cely dokument je

rozdéleny do n€kolika ¢asti zodpovidajicich nasledujici otazky:

o Jaké jsou poZadavky kladené na vzdé€lavani?

Co je to e-learning?

Jaké jsou dlivody a vyhody pouZivani e-learningu?

Jaké organizace urcuji e-learningové normy a trendy?

Co je to SCORM?
Dile nésleduje ¢ast vénovana
¢ Popisu a struénému tvodu do prostiedi LECTURNITY.

V ramci bakaldiské price byl vytvofen uceleny multimediilni kurz programovani v
jazyku C, ktery studenti mohou dostat na CD a pouZivat jako doplnék vyuky
programovacich jazykt. Komplet obsahuje 11 vykladovych lekci doplnénych
jednoduchymi ilustrujicimi ptiklady. Kromé toho je na CD obsaZena kapitola nastifinjici
stavbu programu uréeného k feeni zndmé logické hry SUDOKU. V3e je vytvoieno v
prostiedi LECTURNITY, které TU v Liberci dostala jako soucdst e-learnigového
systtmu CLIX zakoupeného v roce 2004 a dodaného v kvétnu 2005. Popis prostiedi
LECTURNITY ma slouzit jako uzivatelska pfirucka pro tviirce dalsich multimedialnich

pomticek.



1 Jaké jsou pozadavky kladené na vzdélivani?

PiestoZze uZz ze samotného pojmu 'e-learning’ je citit sepjeti s udenim se a s
vyuovanim, zamysleme se nad odpovédi na otazku poloZenou v nadpise tohoto oddilu
textu. ProtoZe nemam potfebné pedagogické zkuSenosti ani vzd€lani, nabidnu vim misto
vlastmi odpovédi citaci z knihy Hovory s T. G. Masarykem. Pile se v ni: “... fika se Ze
dobra Skola uSetif penize za krimindl, $pital a chudobinec. Dobra vychova a dobré uceni
ma byt co nejindividudlngjsi; v tom déldme u nas fadu pokust, ale ji bych jich délal
jesté vic, ale pravé individualisace $koly vyZzaduje - téch penéz!". Kniha vySla v roce
1937, a je nutno podotknout, 7¢ poZadavky na formu vzdélani se za bezmdla sedmdesat
let od jejtho vydani 0 mnoho nezménili. PoZadavek na individualizaci vzdélavani nejen
Ze zlstdv4, ale tato potieba nabyva v souvislosti se zrychlovanim Zivotniho tempa, stile
vétsich rozméri. Méni se pouze technické prostfedky k dosaZeni tohoto cile. Prave
technicky pokrok ndm umoZnil realizaci celé fady pokus, po kterych volal Pan
prezident Masaryk a dovedl nas az k dnes jiZ hojné rozsifenému a neustile silngji se
prosazujicimu e-learningu. S rozvojem e-learningu miZe byt kromé téméf dokonalé
individualizace docileno také sniZeni ndkladd na vyuku. Samoziejmé musi vyukové
materidly nékdo vytvofit a upravovat, ale zabere to podstatné méné ¢asu, fyzickych a v
neposledni fadé také duSevnich sil nez opakovany vyklad téze latky pied tfidou. Méné

zaméstnancem odpracovaného ¢asu znamena pro zaméstnavatele snizeni nakladi.

2 Co je to e-learning?

Co je to vlastné ten e-learning?. Odpovéd je silné zavisla na uhlu pohledu, ndzoru,
technickych moZnostech a znalostech dotazovaného €lovéka. Na to co je to e-learning
odpovi docela jinak s pocitaci spiateleny laik a jinak odpovi profesional s dlouhou fadou
profesnich zkuSenosti. V téhle praci ma samoziejmé hlavni slovo formalné spravny,
profesiondlni piistup spoutany normami a konvencemi, ale pfesto si myslim, Zze by bylo
chybou nepfipomenout to co si pod e-learningem piedstavuje fada nezasvécenych
uzivateli pocitate. Tento piistup jsem zvolil ze dvou divodl. Zaprvé proto, Ze e-

learning se od svého vzniku ménil a vyvijel. Jeho moZnosti se rozSifovaly a spolu s tim
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se vyznam onoho pojmu pozvolna ménil. Co bylo za e-learning pokladano 'véera’, to je
dnes uz davno prekonané. Druhou véci, kterd mé pfiméla vzpomenout si na nezasvécené
laiky, byla skute¢nost, Ze to neni dlouho od doby, kdy jsem mezi né€ také patfil a proto se

na e-learning podivam nejprve z jejich thlu pohledu.
2.1 Dokumenty

Jeden z nejobecnéjSich piistupt fika Ze e-learning je vyuZiti informacnich technologif
v procesu vzdé€ldvani. Zpisobd onoho vyuZiti je celd fada. Jejich zdkladni podstata se
oviem shoduje. Primarnimi cili jsou ziskdvani, uchovani, ptedani a ptipadnd aktualizace
ur€itych informaci (poznatki, obsahu). Z toho vyplyva, Ze jistou formou e-learningu je
prakticky jakykoli dokument s obsahem orientovanym na vyuku. Na této trovni jsou u
nis bezesporu nejpouZivanéjS§imi formaty textové dokumenty vytvofené napiiklad v
nékterém z textovych editori jako je MS Word nebo progresivni, plivodné pro Linux
uréeny OpenOffice.org Writer. Ddle si nesmime dovolit nevS§imnout si, v posledn{ dobé
velice siln€ pouZivaného, formatu PDF. PDF-soubory jsou Citelné pod obéma dnes
nejastéji pouzivanymi OS (Linux, Windows), ale jejich nevyhodou je skute€nost, Ze
nejsou dostatedné rozSifeny nastroje k jejich editaci a tak prost€ nezbyva neZz piijmout

to, ¢o je v nich psdno.

Vyznamnym krokem a prostiedkem ke sdileni informaci se stal Internet. Pfipojeni k
siti nabizi velké mnoZstvi komunikacnich moZnosti. Informace je moZno si piedavat

prostiednictvim e-mailu, HTML-stranek, FTP-serverii nebo tfeba videokonferenci.

2.2 Prezentace

Hranici software-u orientovaného piimo na vzdélavani a podporu vyuky stiezi
prezentani nastroje zastoupené MS PowerPoint-em nebo OpenOffice.org Impress-em.
Tyto programy piesouvaji problematiku vyuky od prostého piedkladani fakt jako celku,
k jejich zajimavé€jSimu, ¢asto multimedidlnimu, postupnému vykladu. Zdiraznéme, Ze
tyhle jednoduché prezentacni néstroje jsou uz vice zaméfeny na formu vyuky. Napiiklad
MS Powerpoint nabizi volbu typu formétovani podle zamysleného zplisobu vykladu
latky. Implicitnim nastavenim vystupu je samoziejmé prezentace na obrazovce pocitace

(resp. projekce na plitno), ale stranou nejsou ponechdny ani dalSi moznosti. Prezentace
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jde formatovat k vystaveni na internetu, tisknuti na ¢ernobilé nebo barevné félie pro
zpétny projektor a moZna je také viprava formatu pro vyrobu diapozitivi. Posledni dvé
(resp. tfi) zminéné alternativy nahravaji technicky hiife vybavenym u¢ebndm a finan¢né
slab$im subjektiim s potiebou udrZzovani vzdélanosti zaméstnanci (resp. studentil) na

vysoké drovni.
Priklad:

Uvedme si piiklad takové situace. Predstavme si tieba stiedni Skolu, feknéme
Gymnézium, které m4 ve vybranych uéebndch moZnost projekce na platno. Zarovei s

-

tim vlastni $kola velké mnozstvi projektort urenych k promitani félii nebo diapozitivi.
Takovy stav panuje v soucasnosti na celé fadé skol. Obcas se v nékteré ufebné objevi i
novy dataprojektor, ale vzhledem k tomu, Ze ceny dataprojektori se stdle pohybuji v
fadech desitek tisic korun, tak se jednd o pomérné vysokou investici, kterd se pii
obéasné projekci malé skupiné lidi (30 lid{ ve tiidé) nemiiZe vyplatit. Z tohoto diivodu
je Casto schiidné&jsi a hlavné levnéjsi cestou nechat si vyhotovit félie nebo diapozitivy a
promitat je prostfednictvim piistroji, které jsou na konkrétnim pracovi$ti k dispozici.
Timto pfistupem se sice pfipravime o multimedidlni komponenty prezentace, ale

usetiime za dataprojektor a za kurzy prace uditeld s poditatem a dataprojektorem.

Regen{ situace popsané v piedchdzejicim piikladu je sice moZné, ale pfiznejme si, e
jde o vychodisko vybrané z nouze. Touto volbou bychom se pfipravili o to, co déla
prezentace zajimavymi a poutavymi. O multimédia. Zvukovou slozku vykladu by musel
stile zajistovat vyuCujici. Navic tento piistup stile neumoziluje zadanou individualizaci
vyuky. Musi se vzdy sejit celd tiida a pedagog. Udé&la se prezence a nikdo se pfi ni
vétSinou nikoho neptd, zda tento termin viem vyhovuje. Po piedneseni latky je z
hlediska Skoly vSechno hotovo. UCitel si fekne: "Piednesl jsem. Budete umét!".
Néadhera. Piitom by jist€ celou vyuku zpestiilo a zatraktivnilo a zefektivnilo kdyby k ni
byla vyuZita kapku novéjsi technologie a vyklad by byl zpestieny vloZenim nahravky,
zvuku, videa, klipu nebo animovaného obrazku. Navic by Slo, za spoluprice ucitele a
poskytnuti piislusnych prezentaci, celou latku si kdykoli a kdekoli, za pomoci pocitace,

opakované pfipomenout.
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2.3 Bez ucitele? Nikdy!

Po kritice v pfedchozim piikladu si zdiiraznéme, Ze cilem e-learningu neni, podtrhuji
neni, fyzicky vyfadit z procesu vyuky ucitele. Casto je stile velice Zidouci jeho
piitomnost pfi vyucovini. Zpisob vyuky, pfi niZ se schidzi{ pedagog se studenty v
ur¢eném d¢ase, fyzicky nebo treba pfes internet na jednom misté, je oznaCovin jako
vyuka Synchronni. Opakem je vyuka Asynchronni, kterd probihd bez piitomnosti
pedagoga na misté zvoleném studentem, v ¢ase kdy se mu to hodi a tim tempem jaké si
samotny student zvoli. V souvislosti s otdzkou Zadanosti piitomnosti vyuéujiciho se
seznamme § pojmem postihujicim kombinované zplisoby vyuky. Tim pojmem je

'Blended learning’. ‘Blended learning’ si piedstavme na dalSim piikladu.
Priklad2:

Podivejme se na Autoskolu. Zijemce o fidi¢ské opravnéni musi mit nutné teoretické
znalosti k fizeni motorového vozidla a musi projit praktickymi zkouskami fizeni.
Teoretické znalosti ziskd €lovék z piirucky, kterd je zatim nejcastéji tisténa, ale do
budoucna se jen stéZi vyhne digitalizaci a e-learningovému zpracovani. Provéfeni
znalosti je provedeno formou testu. Praktickd zpisobilost uchazede je testovana jizdami
pod dohledem instruktora. Jen stéZi si lze piedstavit situaci, kdy by stadilo k ziskani

fidi¢ského opravnéni pouhé dspeésné absolvovani teoretického testu. Jizdy jsou nutné.

O 'Blended learningu’ se oviem mnohem {ast€ji hovoifi aZz v souvislosti s daleko
rozvinutéjsimi technologiemi nez jsou zmifované prezentace. Prezentacemi totiZ vyvoj
programovych vyukovych ndstroji nekonéi. Existuje fada produkti, které se neomezuji
na pouhé pfedkladani (byt s multimédii) vyucovanych informaci ale jdou dil. Takové
produkty uZ nejsou uréeny vyhradné na piedavani informaci, ale podporuji také dalsi
formy vzdé&lavaciho procesu poskytujici moinost uchovani predané informace,
zvySovani praktickych dovednosti, umoZiiujici naslednou kontrolu procesu vzdéldvani a
daldi. Jejich soucdstmi jsou programy pro provadéni testd, komunikaci s vyufujicim
(autorem materidlu) a fadou dal¥ich ndstroji. Metou, které se snazi e-learning
dosdhnout, je zaclenéni vyuky do normAlniho, kaZdodenniho, pracovniho Zivota

studenta (resp. zaméstnance). AZ bude teoreticka ¢ast vyuky v autoskolach zpracovina

jako e-learningova prezentace, testy opusti archy papiru, komunikace s vyucujicimi

13



bude probihat v elektronické podobé a jizdy zistanou tak jak jsou, potom se bude moci

e

podle dnesnich méfitek mluvit o ‘Blended-learningu’.
2.4 Forma e-learningu

e-learning se svym pojetim stdle vice a vice soustieduje na zphsob piedavani
informaci a timto se neustéle pfiblizuje k knowlege-management-u a pole jeho pouZiti se

rozdifuje o vytvaieni reklamy riznym spole¢nostem, firmam, sluzbam a vyrobkém.

2.5 Obsah e-learningovych lekci

E-learning mé tfi soufdsti. Prvni a zdkladni stavebni kostkou je obsah. Obsah je
bezesporu vysoce diileZitou slozkou e-learningu a vzd€lavani jako takového wibec.
Tviirce (resp. tvilirci) vyukového materidlu by méli byt schopni soustiedit se na diileZité
¢4sti probiraného tématu a psit obsah z didaktického hlediska korektng. Pro zajisténi
zminéné korektnosti a srozumitelnosti obsahu je vhodné konzultovat uspofadani obsahu
s pedagogem. Obsah miZe mit format libovolného dokumentu slucitelného s e-

learningovymi standardy. Casto vyuZivanym formatem jsou prezentace.
2.6 Organizovdni vyuky (LMS)

Druhou dilezitou soucasti e-learningu je tzv. LMS (Learnning Management
System=="fidici syst¢ém"). LMS m4 na starosti kompetence a fizeni vyuky. MoZnosti
LMS-produkth riznych vyrobch se mohou dost vyrazné lisit. Nejjednodussi programy
tohoto typu jsou vvhradné spoustéci elektronickych kurzii, kterymZto omezenim
neposkytuji fadu prostfedkit pozdvihujicich proces vyuky na poZadovanou urovetl.
Naproti tomu propracovanéjsi fidici systémy timto nedostatkem netrpi. Obsahuji

roziifujici funkcionality typu:
¢ Evidence a fizeni riznych druht vyuky
e Katalogi vyukovych lekci, katalogi studentii (resp. studujicich)

o Sledovani aktivit studujicich a posuzovan{ efektivity kurzid na zakladé v testech

dosaZenych vysledki

e Nistrojli ke komunikaci mezi studenty a vyucujicimi (resp. studenty mezi sebou)
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Splnéni prvniho pozadavku (evidence a Fizeni riznych druhit vvuky) zajistuje
moznost volby zpisobu piredloZeni e-learningového kurzu. Vybranou lekci jde ve
vysledku ulozit ve formatu uréeném bud pro samostatné shlédnuti studentem
(asynchronni kurz) nebo ve formatu pro vyuku ve virtudlni tiidé (popf. pro vyuku v

ufebné, synchronni kurz). Tim je vyfeSen problém logistiky doddvan{ kurzt.

Druhy bod z vyseuvedeného vyétu (katalog vyukovych lekci, katalog studenti) Zada

udrZeni pfehledu o vyhotovenych kurzech a studujicich, ktefi je absolvuji.

Bod tieti vypichuje dohled nad Cinnosti jednotlivych studujicich. LMS si mize
udrZovat tieba informace o tom jak dlouhy &as stravil konkrétni ¢lovék studiem
jednotlivych kapitol piedlozeného kurzu a jak se doba vé€novand studiu odrazila na
vysledcich testli. Na zdklad€ takovychto informaci o v&tSim poctu studujicich je mozné

hodnotit efektivitu kurzi a jako odezvu kurzy modifikovat.

Zv14stni dileZitost ma tvrty poZadavek(nastroje ke komunikaci mezi studenty a
vyufujicimi a studenty mezi sebou). Komunikace s vyucujicim nebo spoluzikem je
diilezitd zejména v piipad€, Ze prednesend latka neni okamZité, bezezbytku pochopena a

je potfeba ji dovysvétlit.
2.7 Tvorba kurzu(LCMS)

Po obsahu a fidicim systému (LMS) m4 e-learning jesté tieti ¢ast oznalovanou

zkratkou LCMS (Learning Content Management System). LCMS je systém ndstroji

s s o

slouZicich ke tvorbé obsahu rozsifeny o ¢asti fesici vikoly s tvorbou obsahu spojené.
Témito ukoly jsou:
¢ Zajidténi tymového procesu tvorby obsahu
¢ Sprdva a znovupouzivani zdrojii obsahu
e Skladani u¢ebnich jednotek libovolného rozsahu
e Poskytnuti moznosti editace obsahu koncovému uZivateli

e UdrZovini piehledu o aktivitich koncového uZivatele s u¢ebnimi jednotkami

15



¢ Podpora vyukovych strategii e-learningu
¢ Interoperabilita

¢ Prijatelnd cena

2.8 Prace ve skupiné

Zajisténi tymové spoluprace na sestavovani obsahu vyuky je nezbytné pro dosaZeni
optimalniho spojeni vé&cné spravnosti vykladu s jeho poutavou formou. Ve
spolupracujicim tymu se stietdvaji lidé s riznymi pohledy na feSeni piedklddanych
problémi. Nevyhnutelng€ dochiazi k nazorovym neshoddm. Jejich vysledkem je, v
piipad¢€ dialogu, bud’ nepouzitelny kompromis nebo vzdjemné piinosné propojeni
jednotlivych piedkladanych idei. Pfi praci jednotlivce je situace jind. Pracuje-li Clovék
sam a izolované, pfipravuje se tim o moZnost pribézné konzultace vysledk{ svoji prace
s okolim a kvalita vyrobku nepfitomnosti zpétné vazby vétSinou poklesne. Pravé z
tohoto diivodu je vysoce Zadouci aby LCMS-systém poskytoval podporu tymovému

procesu vyroby obsahu a umoZioval tviircim vzdjemnou kmunikaci.

2.9 Recyklace obsahu

Druhy pozadavek (Sprdva a znovupouiivdni zdroji obsahu) se d4 dle mého nazoru
vysvétlit asi takhle. Obsahem budiz tieba obrazek. Obrazek jednou pouziji v kurzu, ale
nepiipravim se tim o moznost vkladat ho do dalSich kurzi znova a znova. Obrazek se
zkratka nikam neztrati. LCMS si vytvoii jakousi kopii obrazku, s tou bude pracovat a o

ni si bude uchovdvat informace. Napiiklad vi, kde je ulozena, pouZita atp. (Sprdva ...).

2.10 Cilend zména skladby kurzu

Skladanim uéebnich jednotek libovolného rozsahu je bran ohled na to jaké skupiné
lidi a k jakému udcelu je e-learningovy kurz uréeny. Jednoduse fedeno, jinak je nutné
piistupovat ke kurtim filozofie na fakulté¢ Mechatroniky Technické univerzity v Liberci a

jinak na Filosofické fakulté¢ UK.
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2.11 UZivatelska editovatelnost

Z hlediska koncového uzivatele je velice vitina moZnost editace kurzu. Piipadné
vepisovani poznamek nebo drobné zmény ve formulaci obsahu silné pfispivaji k

pochopeni konkrétniho problému.

2.12 Autoruy dohled

Pro autora je piinosné udrzovat si pfehled o zmé&nach provedenych ve vyukovych
jednotkach. Je tomu tak proto, Ze koncovy uZivatel kurzu, tedy uZivatel ktery se
nepodilel na vyvoji kurzu, miize tviirci pomoci odhalit celou fadu chyb, popiipadé mu
miize poskytnout zajimavé podnéty k rozSifeni, doplnéni a zpiehledn&ni kurzu. Kvalitni

LCMS-systémy na tuto formu komunikace pamatuji.

2.13 Dodrzent standardii

Podpora vyukovych strategii e-learningu je dileZitd z n€kolika divodi. Prvnim a
snad nejdiilezitéj$§im divodem je mozZnost fizeni kurzli sestavenych v ur€itém
konkrétnim LCMS pomoci LMS od jinych vyrobcti. JestliZze kurzy nebudou spliiovat
stejné standardy a normy, pak bude s nejvy3si pravdépodobnosti nutné pracovat s LCMS
a LMS od jednoho vyrobee. To by ve vysledku mohlo vést ke vzniku spousty malych,
viceméné regiondlnich komunit, které by 'mluvily riznymi jazyky a navzdjem by si
vilbec nerozumnély'. Podporovani vyukovych strategii e-learningu zamez{ nazna¢enému
'zmateni jazykl'. Dani za to, Ze si budou vSichni rozumét, miiZze byt jisté sniZeni
vyjadiovacich schopnosti. Prost¢ nebude mozné ve standardu zachytit a pouZit kaZzdy
dobry ndpad, kaZdou slibné vypadajici technologii, ktera se objevi. Dal§im diivodem k
podpofe vyukovych strategii e-learningu je poZadavek na upravitelnost hotového kurzu
v jinfm LCMS neZ ve kterém vznikl. Tento pozadavek miZe byt vyvolan napiiklad

zménou verze LCMS nebo piechodem k pouZivani LCMS od jiného vyrobce.

2.14 Kombinujme (Interoperabilita)

Interoperabilita je mozZnosti stavét obsah z vice nezavislych celkd rizného druhu. To
znamena tieba, Ze obsahem nebude pouze text, ani jenom obrizky, ale Ze jde pouZit

oboji. Obecné to znamena, Ze mohu vytvorfit ¢ast obsahu v programu A, st obsahu v
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programu B, ¢ast obsahu v programu X a v LCMS tyto komponenty posklidat do

jednoho celku.
2.15 Cena/PHnos

ProtoZze vSichni jsou limitovani finanénimi prostfedky, které maji v danou chvili k
dispozici, musime se pii volbé LCMS ohliZet také na cenu produktu a véaZit, zda tato
odpovida jeho kvalit® a naSim poZadavkiim. JednoduSe jestli na to mame, popiipadé

jestli se zamysSlend investice vyplati.
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3 Jake jsou diivody pro pouzivani e-learningu

Cilem vétSiny lidskych Cinnosti, s vyjimkou charitativnich akci, je v souCasné dobé
dosahovani finan¢niho zisku. Zaroven dochazi ke zrychlovani vyvoje novych technologif
a stdle uZ¥ oborové specialazaci zaméstnancii. Po zvdZeni téchto dvou skutecnosti
musime dojit k zdvéru, Ze pro uchovani konkurenceschopnosti firmy je nutné jeji
zaméstnance pribézné dovzdélavat. Otidzkou je zpisob, jakym ono dovzdélavani
efektivné realizovat. Abychom si utvofili pfedstavu co to znamena 'efektivné realizovat',
podivame se podle jakych méfitek je efektivita (resp. kvalita) vyuky hodnocena. Model,
ktery se k hodnoceni efektivity pouzivd, vznikl v druhé poloviné 20-tého stoleti na
Wisconsinské univerzité. Autorem prvnich Ctyfech bodi je Donald L. Kirkpatrick.

Rozsiteni o paty bod provedl pozdéji Jack Philips. Zminénymi body jsou:
® Reakce
o Wuka
o  Chovdni
o Wisledky
e Ndvramost investic
3.1 Reakce studentit

Prvnim méiitkem pro posouzeni kvality vyuky jsou bezprostiedni reakce studentd
béhem jejiho prib&hu. Reakce se samoziejmé tykaji zejména synchronniho zpisobu
vyuky probihajici za pfitomnosti vyucujictho. OvSem u obou typQ vyuky (synchronni

vs. asynchronni} je moZné sledovat spokojenost studentii s vyukou.
3.2 Nové znalosti (Vyuka)

Dile nas pii posuzovani efektivnosti kurzi zajima co se studujici jeho absolvovanim
naucil. Bod oznaeny Vvuka postihuje teoreticky posun znalosti a zménu postoji a

stanovisek k feSeni problémi.
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3.3 Zmény v chovdni

Co se tyCe Chovdni, klademe si otazku jestli vedla absolvovana vyuka k jeho zméné.
Viimime si, jak dokaZe absolvent kurzu prakticky aplikovat teoreticky nabyté

védomosti a hodnotime, zda jsou nové navyky zménou k lep$imu nebo k hor$imu.

3.4 Vysledky

Visledky (resp. zlepSeni vysledkl) jsou cilem veSkeré lidké ¢innosti a vyjimkou neni
ani organizované dovzdélavani. Maji jimi obvykle byt zvySeni vykonnosti, zvy3eni
produktivity a tim vyvolany vzrist zisku spole¢nosti. Zmény vysledki v zavislosti na
pribéiném dovzdélivani je ale velice obtizné hodnotit, protoze na vysledcich se
podepisuje kromé ¢innosti firmy také fada vnéjsich, trznich, ekonomickych faktorii jako

jsou napfiklad naplnéni poptivky po daném vyrobku nebo konkurence v oboru.

3.5 Hodnoceni ndavratnosti

Podobné sloZitym tkolem, jako je ureni podilu dovzdélavani na zméné vysledki
firmy, je v piipadé¢ e-learningu také stanoveni Ndv rarmosti investic. K popisu nivratnosti

investic v procentech slouzi ekonomicky ukazatel Rol definovany vzorcem:

Celkavy zisk — Naklady
= *100
Naiclady
Vyznam vzorce je ziejmy. Rol #k4d o kolik procent prevysil celkovy zisk naklady a je

Kol

jednozna¢né patrné, Ze cilem firmy je aby tento ukazatel dosahoval dlouhodobé co
mozna nejvyssich hodnot. Toho lze docilit dvéma zpisoby. Zvysenim zisku nebo
snizenim nikladd. Ke zvyseni zisku vede piim4 cesta pres zvyseni produktivity prace.
Ke zvySeni produktivity prace a zdroven také ke sniZeni ndkladh mbZe piispét volba
vhodné formy vzdélavani zaméstmancd. Pravé v dosahovini t&chto dvou cilid e-learning
velmi vyrazné pomahd. Pii volbé e-learningu dojde totiz k automazici managementu
vyuky. To se projevi ve sniZeni ndkladd, protoze jednordzové investice do ndkupu
pocitacli, zfizeni podnikové sité, obstardni potfebného software-u a tvorby e-
learningovych lekei vyjdou jednoznaéné levnéji neZ dlouhodobé zaméstndvani lidi.
Navic miiZze byt v piipad€ e-learningu potladena potieba pronajimat, popiipadé vlastnit a

udrZovat prostory nutné pii klasickém zplisobu vyuky.
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4 LECTURNITY

LECTURNITY je soubor aplikaci ureny k multimedializaci procesu vyuky a je
dilem némecké softwarové firmy imc AG sidlici ve Freiburgu. Nastroje v Lecturnity
obsazené slouZi ke snadné multimedializaci a oZiven{ navrzenych vyukovych prezentaci
vytvofenych v PowerPointu. LECTURNITY se skladd z programti LECTURNITY
Assistent, LECTURNITY Editor, LECTURNITY Publisher, LECTURNITY CD
Publisher a LECTURNITY Player. V tomto oddile nastinim postupy zminéné
multimedializace a oZivovani a spolu s tim si fekneme, co dél4 ta kterd konkrétni ¢ast
LECTURNITY. Celou proceduru ptehledné zachycuje piiloZzeny obrizek z anglického

manudlu k Lecturnity.

4.1 Proces vzniku kurzu

Prvni fadek iik4, Ze nejprve musime vytvofit koncepci, tj. PowerPointovou

prezentaci. Po vytvofeni prezentace budeme pracovat s ndstroji baliku LECTURNITY a

po skonceni téhle prace dostaneme multimedidln{ aplikaci (resp. Video).

Production with LECTURNITY Application

LECTURNITY LECTURNITY LECTURNITY
Source Document Record Document Record Document

Na druhém az ¢tvrtém fadku je zachycena celd procedura jiZ je nutno na cesté od
PowerPointové prezentace k multimedidlnimu vyukovému kurzu projit. Postupujme

podle Sipek zeshora dolti a podle intuice zleva doprava.
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Na zac¢atku ve fazi piipravy vytvofime PowerPointové slide-y. Pokud jsou PowerPoint
(PP) spolu s Lecturnity instalovdny na jednom stroji, pak se v PP-ovém menu v nabidce
Soubor objevi dvé nové polozky, které PP implicitné neobsahuje. Prvni z nich je Save as
LECTURNITY Source Document a jde tedy o export .ppt socuboru nebo jeho ¢asti do
jakéhosi opakovatelné¢ pouZitelného zdrojového formatu pro Lecturnity Assistant,
Vznikly soubor md pfiponu LSD. Druhd volba nese oznafeni Open with
LECTURNITY Assistant. Pi jejim pouZiti se nic neuklddd. Nevzniki Zadny LSD-
soubor a z tohoto diivodu se tenhle postup hodi spiSe pouze pro jednordzové operace,

kontroly zobrazeni nebo tieba doplnéni existujici prezentace o chybéjici snimek.

Vytvoifeny LSD-dokument je mozné, vlastné spiS nutné, editovat v LECTURNITY
Assistant-u. Po otevieni Assistentu je uzivatel donucen oteviit existujici nebo zaloZit
novy projekt a poté miZe svoje importované snimky dle libosti napfiklad doplnit
mluvenym komentidfem. Pravé zvukovd nahrivka je nosnou slozkou souborl *.Ird
(LECTURNITY Record Document), které jsou vystupnim formatem LECTURNITY
Assistentu, Tedy, pod ¢im neni nahrany zvuk to se z Assistentu nedostane. Tato faze

vyvoje je piizna¢né oznacena Recording (nahravéani).

Vysledek nahrdvani jde upravovat v LECTURNITY Editor-u. To se hodi pii
odstratiovan{ piili§ dlouhych promlk atp. Pouzivini LECTURNITY Editor-u neni vZdy
nevyhnutelné nutné. LECTURNITY Editor ma sviij interni souborovy format *LEP
(LECTURNITY Editor Project).

Upravené, ozvucené snimky se pievadi z editovatelného *LRD do vybraného
formdtu urceného k piehravani. Diivodem k tomuto pievodu je zajiSt&ni kompatibility a
zmensdeni velikosti vyhotovenych lekei. Tento dkol fedi LECTURNITY Publisher. Po
pouziti LECTURNITY Publisher-u tak vznikne bud *. LPD (LECTURNITY Player

Document), nékteré z videi RealMedia, WindowsMedia nebo flash animace.

Césti u pravého okraje obrdzku ukazuji, Ze hotovy dokument je tfeba né&im prehrit.
Tim né¢im budiz tfeba pfehrdva¢ videa nebo web-browser. LPD- stejné jako LRD-
dokumenty je moZno piehrit v LECTURNITY Player-u.

Posledni ¢asti LECTURNITY, kterd zatim nebyla zminéna a na obrdzku je
vynechina je LECTURNITY CD Publisher. LECTURNITY CD Publisher pomaha pii
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umisfovani hotovych LPD-souborti na CD-nosice a tim ulehcuje jejich organizovani do

vétsich celki.

V nejspodnéjsich ¢astech pii dolnim okraji obrdzku jsou zapsina jména konkrétnich
aplikaci pouzivanych be€hem realizace piislusnych fizi vyvoje multimedialnich

prezentaci.
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5 LECTURNITY Assistant

LECTURNITY Assistant je hlavni, potaZmo nejdileZit€jsi program z baliku
LECTURNITY. Do Assistant-u jsou importovany zdrojové soubory *.LSD, v Assistant-
u jsou zakladany a spravovany projekty zastieSujici celou prici a v Assistant-u je tvofen

také zdklad celé dalsi prace, soubory *.LRD .

LECTURNITY Assistent miiZzeme oteviit nékolika zptsoby. Prvni zpiisob jsem uZ
zminil . Je jim PP-volba v menu Soubor->Open_with_LECTURNITY_Assistent. Pii
tomto zplisobu otevieni asistentu nemdme moznost volby slide-i, které chceme
pouzivat. Z PowerPointu jsou pieneseny vsechny slide-y oteviené prezentace. Otevirdni
LECTURNITY Assistent-u z PP tak davd smysl pouze tehdy, jestlize chceme rychle
vidét vysledky své price. Druhym zplisobem otevieni LECTURNITY Assistent-u je

klasické poklepani na ikonu aplikace v mist€ jeji instalace.
5.1 Zpravovdni Projektit

Startovacim bodem pii tvorbé multimedidlnich prezentaci jsou LSD-soubory. Z
téchto souborti nebo z jejich Casti jsou vytvafeny nahriavky, tedy soubory s piiponou
LRD. Skupiny LSD- a z nich vytvoifenych LRD-soubort tvoii zpravidla projekt. Projekt
uchovava informace o nastaveni v sob& sdruZenych nahrivek a fady jinych véci jako
jsou jako jsou napiiklad videa, screengrabbingové klipy a metadata. V piipadé, Ze je v
priitb&hu prace s projektem otevien LSD-soubor ktery neni soulasti projektu, dojde k

jeho automatickému zaclenéni do projektu a od té chvile pro né€j plati nastaven{ projektu.

Pii otevieni Assistant-u se objevuje dialog umozZiiujici oteviit existujici nebo vytvofit

novy projekt. Pro dal3i popis je pfedpoklddana volba vytvofeni nového projektu.
5.2 Nastaveni Projektu

JestliZe jste v pfedchozim dialogu vybrali vytvofeni nového projektu, objevilo se
okno Project_Settings. Toto okno 1ze kdykoli pozdéji vyvolat z menu LECTURNITY

Assistant-u volbou Extras -> Project Settings.
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7 beprace? - Assistant

File Edit View Insert Estraz 7

o f ° ' Project Settings
‘%J Mﬁ‘- Ewplore LECTURMITY Home Chrl+H
[Document Structure [l

Ve zminovaném okné jsou k nalezeni vSechna diileZitd nastaveni projektu. Nabidnutd
nastaveni jsou obvykle provedena natolik citlivé, Ze neni nutné ménit a ur€ovat nic vic
nez cestu uloZeni projektu. Nastaveni je v zdkladu rozdé€leno do tif ¢asti zobrazenych na

zalozkach:
e (General
e Screengrabbing

e Presentation Bar

s

5.2.1 General

Podzélozka Source&Destination slouzi k pfiddvani (resp. odebirdni) zdrojovych
dokumentii do/z projektu a ddle k nastavovani vyse zminénych cest pro ukladani ¢asti
projektu. Manipulace s podzdlozkou Source&Destination je shrnuta v ndsledujicich

bodech.

1. Pro pfidani LSD-souboru kliknéte na tlacitko Add. Objevi se dialogové okno pro
nalezeni a vybér zdrojového souboru. Po vybrani konkrétniho souboru kliknéte na
tla¢itko Open. Dokument bude do projektu zafazen za aktudlné¢ vybrany LSD-

soubor.

2. Stisk tla¢itka Remove vyvold vymazani vybrané¢ho zdrojového dokumentu z

projektu.

3. Dvéma dilezitymi volbami jsou zvoleni domovského adresafe LECTURNITY
(resp. Projektu) a vybér adresife pro ulozeni nahrdvek, tj. LRD-soubori. V

domovském adresdii sice dojde implicitn€ k vytvoieni sloZzek CD_Projects,
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Recordings a Source_Documents, je oviem pouze na ufivateli zda jich bude

vyuZivat.

Dalsi zajimava podzdlozka je oznafena Metadara. Obsahuje polozky Title, Author,
Creator a Keywords. Tyto poloiky jsou uréeny k popisu vytvafeného dila. BliZsi

pojednani o metadatech je k nalezeni v dal3im textu.

Na podzéloice Audio jsou véci jako volba pouzivaného zvukového zaiizeni (Device),
piesnost vzorkovani (Sample Widih), frekvence vzorkovani (Sample Rate), pouZivany

zdroj zvuku (Audio Source) a jeho citlivost.
Volby pro nahravani videa jsou na podziloZce Video.
5.2.2 Screengrabbing

Jde o moZnost nahrdvat ve vybraném video-formatu udilosti ve zvolené Casti

obrazovky. Na této zaloZce jsou polozky pro volbu video-formétu atp.
5.2.3 Presentation Bar

Presentation bar je ¢dst okna LECTURNITY Assistant-u (viz. dile) a v této sekci

nastaveni je moZno urovat nastroje, které jsou z téhle listy piistupné.

Poté co nastaveni hotové, provedte jeho uloZeni. K uloZeni{ nastaveni dochazi

soudasng s uloZenim projektu.
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5.3 Prostredi lecturnity Assistentu

Prostfedi LECTURNITY Assistentu je ¢lenéno takovym zplisobem, aby umoZiiovalo
snadnou a efektivni manipulaci s importovanymi snimky. K popisu Assistentu slouZi

ndsledujici obrazek.
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Z obrdzku je patrné, Ze pracovni plocha je rozdélena na nékolik ¢asti. Nejveétsi a
nejdalezité€jSi je Presentation_area. V této Casti jsou zobrazovdny a upravovany
importované snimky. Pii levém okraji obrdzku leZi oblast se stromovou strukturou
zdrojovych souborl (Document_Structure) a oblast s historii pofizovani nahravek
(Recording_History). Ve spodnf ¢asti obrazovky Assistentu se nachdzi liSta s néstroji
pro pofizovani nahravek a dpravu snimki v prib€hu nahravani (Presentation_Bar). Tak
jako vétSina programi urCenych pro Windows, obsahuje také LECTURNITY Assistant

svoje Menu a nastrojovou liStu (Toolbar).
5.3.1 Presentation Area

V predvadeci oblasti (Presentation Area) jsou zobrazovany snimky ze zdrojovych

dokumentti, které jsou souéasti projektu. Snimky jde upravovat nastroji zobrazenymi na
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Toolbar-u, v Menu nebo na Presentation Bar-u. Viechny tyto tpravy lze provadét pred

nebo v pribéhu nahravani.
5.3.2 Document Structure

Stromova struktura informuje uZivatele o pocétu pouZitych zdrojovych soubord,
Clenéni projektu do kapitol a poctu strinek jednotlivych kapitol. Aktualné zobrazena
strdnka je zvyraznéna. Strinku, kterou si piejeme zobrazit, vybereme jednoduchym
kliknutim levého tladitka mysi na jeji ndzev nebo k jejimu zobrazeni pouZijeme
navigacni tlaCitka z levé Casti Presentarion Bar-u. Uchopenim jména snimku mysSi a
jeho pfetazenim na jiné misto ve zobrazené struktufe je moZné ménit pofadi snimki
v projektu. Stejnym zptisobem jdou znovu uspoiaddvat kapitoly a zdrojové dokumenty.
Daldi mozZnosti je vloZeni prdzdného snimku do dokumentu. Volba vloZeni nového
snimku je obsaZena v Toolbar-u. Novy snimek je vkladdn za slide, jehoZ jméno je
aktudlné vybrino. Nové vloZeny snimek miize poslouZit tfeba k zapsdni poznimek.
V piipadé, Ze klikneme pravym tladitkem mySi na zvyrazné€nou stranku nebo kapitolu,
dojde k vyvolini kontextového menu. Kontextové menu obsahuje volby jako je zména

jména snimku nebo zadani kli¢ovych slov ke snimku.

5.3.3 Recording History

V historii nahravek je zobrazovdn seznam viech nahrdvek, které jsou soucdsti
otevieného projektu. Spolu snahrivkami najdeme v seznamu také vycet vsech
pofizenych screengrabbing-ovych klipli. U vSech poloZek zobrazeného seznamu jsou
zapsdny informace o datu a Case pofizeni nahriavky a o délce jejiho trvani. Z oblasti
s historii nahravek miZe uZivatel po vybrini jedné konkrétni nahravky piimo spustit
LECTURNITY Player, LECTURNITY Publisher a LECTURNITY Editor. Ke spusténi
viech zminénych aplikaci jdou pouzit bud piisludna tladitka ze spodni ¢asti Recording
History nebo kontextové menu vyvolané kliknutim pravého tla¢itka mySi na vybranou
nahravku. Kontextové menu déle obsahuje volbu Remove Entry, uréenou pro odstranéni
nahrivky z projektu, volbu Delete, pouZivanou k vymazani nahrdvky z disku a volbu
Properties, kterd je uréena k dpravé metadat. LECTURNITY Player lze navic oteviit

double-clickem na vybranou nahravku.
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5.3.4 Toolbar

Na Toolbar-u jsou zobrazeny néstroje k editaci snimkt. Informace o funkcich
jednotlivych tladitek (rzv. QuickInfo) jsou zobrazovdny po umisténi kurzoru nad
jednotlivd tlacitka. Po jednoduchém kliknuti na nékteré z tladitek na Toolbaru je
aktivovan pfisluSny ndstroj a ztstavd aktivni do chvile vybéru jiného nastroje nebo do
dalSiho stisku tlaCitka, které jej aktivovalo. To jaky ndstroj je aktivovin, pozndme
pohledem na kurzor mysi, ktery se méni se zménou néstroje. V pifpadé kdy chcete
provadét zmeny na objektu na snimku, musite ho nejprve vybrat. K vybéru objekti je na
Toolbar-u néstroj Select Object. Po vybrani objektu je ho moZno upravovat dle libosti.
Jestlize nen{ vybran zadny z nastroji, potom jde objekty vybirat klinutim levého tlaéitka

mysi.

5.3.5 Presentation Bar

e

na Presentation Bar. Najdeme na ném nastroje jako jsou pastelky a zvyraziiovace
riiznych barev, kterymi jde volnou rukou kreslit, ukazovatko, spousté¢ screengrabbing-u,
tla¢itka pro pfechod mezi sousednimi snimky a tlacitka zafdtek a konec nahrdvéni.

Podobu Presentation Bar-u jde v nastaveni ménit podle vlastnich potfeb a prani.

- o]

Time display Record monitoring

=

B | P
30 |
: - 14 o

Navigation Record control Tools Screengrabbing

5.3.6 Nastaveni Presentation Bar-u

Pro zménu vybéru nastroji zobrazovanych na Presentation Bar-u postupujte
nasledovné. Oteviete poloZku v menu oznaenou Extras -> Project Settings a
v zobrazeném dialogu vyberte zdlozku Presentation Bar. Na této zdloZce oznacte
nastroje, které by jste rddi pouzivali a svilj vybér potvrdte stiskem tlacitka Save as
Default pro globdlni zmé&nu mnoZiny zobrazenych nastrojii nebo Apply pro pouZiti

provedeného nastaven{ vyhradn€ v aktudIné€ otevieném projektu.
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Sipky slouZici k pfechodu mezi snimky mohou byt pfemist&ny do zvolenych oblasti

na Presentation Bar-u nebo mohou byt tipIn€ odstranény.

5.3.7 Nahravani

Pred samotnym nahrdvanim je tfeba provést piislu$nd nastaveni tak aby spliiovala
pozadavky uzivatele. Nastaveni audia a videa je piistupné z menu volbou FExtra->

Project Settings.

Za predpokladu, Ze je nastaveni audia provedeno spravné, mél by pfipojeny mikrofon
reagovat na zvuk pohybem sloupce v Audio control window na Presentation Bar-u.
KdyZ mikrofon reaguje piili§ citlivé nebo naopak jen velmi mélo potom upravte na

zaloZce jeho citlivost.

Project 5 Eiﬂr‘!g@ ] El

[General | Screengrabbing | Presentation Bar |

5 ource & Destination | Yiew | Metadata Audio | Yideo | |

Device:

|0: NVIDIAGR) nForce(TM) Audio ~|
Sample Width (Bit):

e B
Sample Rate (Hz):

22050 - - | )
Audio Source: =
|5: Line In j )

Ok _ Cancel
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5.3.8 Zobrazeni snimku

JestliZze otevieme v menu polozku View, budou ndm nabidnuty volby toho, co se ma
na v okné¢ LECTURNITY Assistentu zobrazit a co ma byt skryto. Nardz je moZné skryt
Document Structure spolu s Recording History. Jde schovat Toolbar. Uvolnéné misto
zaujme vZdy snimek zobrazeny v Presentation Area. Vybér polozky Full Screen nebo
stisk FS vede ke skryti menu a titulku okna Assistentu. Pro skute¢né roztazeni snimku

na celou obrazovku je nutné pied stiskem F5 zatrhnout v menu volbu ViewH ide All

7 beprace? - Assistant

File Edi | View Inset Extrazs ?

41%, [ Full Screen Ef ?
"_"“D ucumer:t_‘ v Toolbar F& —
m v Document Dverviews F7

B pr Hide Al Crl+Ul
% Grd...
El Arrow St
vles...
El
E‘I q h‘ =I-'I= o~ n:r:mﬂlrll

5.3.9 Screengrabbing

Beéhem screengrabbingu vytvaii LECTURNITY video sekvenci rychlych snimdnim
aktudlni obrazovky nebo jeji vybrané Casti. Videoklip vznikly timto zplsobem je
oznacovan jako screengrabbingovy klip a je zafazen do projektu jako polozka spojend se
zvukovou nahravkou b&hem jejthoZ zaznamu byl pofizen. Zaznamenana videonahravka

je uloZena ve formétu AVI.

Screengrabbing je mozné vyuZzit napiiklad pro zachyceni zpasobu prace s urcitym
programem. V pribéhu nahrdvani screengrabbing-ového klipu jde ve snimané oblasti
pouZivat nastroje z Presentation Bar-u. Kontury nakreslené tuzkou nebo zvyraziiovaem

popiipadé pohyby ukazovatka budou ve vzniklém klipu zaznamendny.

Ovladaci prvky pro tvorbu screengrabbingovych videi jsou k dispozici na
Presentation Bar-u. Tladitko Screengrabbing: Start se implicitné nachédzi u pravého
okraje Presentation Bar-u a je na ném mald ikonka obrazovky. Pokud neni spuSténo

nahravani (tj. zdznam hlasu), tla¢itko je neaktivni (vySedlé) a uZivatel s nim nemuze
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pracovat. Po stisku tla¢itka pro nahravini dojde k aktivaci tlaCitka Screengrabbing:
Starr. Obrazovka na ikoné€ ziska riZovou barvu. Po aktivaci startovaciho tlacitka jde,
kliknutim na n&j zahdjit screengrabbing. Assistant je v takovém pfipad€ redukovin na
samotny Presentation Bar a uZivatel je vyzvan k vybéru oblasti, kterou si pfeje snimat.
Vybér probihd nejéastéji taZzenim kurzoru pii stisknutém levém tladitku myS3i.
Alternativni volbou k vybéru oblasti tazenim kurzoru je kliknuti na titulek vybraného
okna. Okno vybrané timto zplisobem bude pieneseno do popiedi a snimanou oblasti se
stane celd plocha, kterou okno zabird. Oblast nahrdvani je vymezena oranZovymi rohy,
které ji ohrani¢uji. Od chvile vybrani oblasti probihd Screengrabbing. Soucasné se
snimanim obrazu dochézi také k zdznamu hlasu. Pokud chcete béhem zdznamu zménit
sledovanou oblast, drzte stisknuté klavesy Ctrl+Shift a rAm pfetdhnéte mySi tam kam
potiebujete. Jakmile si budete piat Screengrabbing ukon¢it, kliknéte znovu na tlacitko
Screengrabbing: Start nebo vyuZijte nadefinované klavesové zkratky. Spolu
s ukonéenim nahravani videa se znovu otevie LECTURNITY Assistant v celé své krase.
POZOR! Tim je ukonéené nahriavani screengrabbingového klipu, ale nadale pokrauje

zdznam zvuku. Zaznam zvuku je tieba ukonéit zv1ast.

Nahrané Screengrabbingové klipy jde z projektu (resp. z disku) odstrafiovat za
pouZiti kontextového menu oblasti Recording Historyv. Podobné jako u nahrivek

obsahuje menu polozky Remove entry, Delete a Properties.

5.3.10 Samostatny Screengrabbing

Proto, aby jst¢ mohli vytvofit nahravku (mySlen LRD-dokument), neni
bezpodmine¢éné nutné vkladat do projektu zdrojovy dokument s pfedpfipravenymi
snimky. Postupu, ktery umozZiiuje vytvofit nahrdvku, kterd nevychazi z pouZiti
zdrojovych dokumentf, se fika pure Screengrabbing. Pokud jej chcete pouZit postupujte

nésledovné:
1. Oteviete Assistant a vytvoite novy projekt bez vkladani zdrojovych soubord.
2. Stisknéte tlacitko se symbolem monitoru (Screengrabbing: Start).

3. Vyberte oblast, kterou chcete nahravat. Tim samotné nahravani zacne.
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Cely proces nahrdvani jde kdykoli pferuSit a na preruSeni poté znovu navdzat

s pouzitim tlaéitek ukdzanych na obrazku.

T |

(" 0:00:13

208 i
[ Te] =T ; = [ Te] = : :
Pause Recording Continue Recording

4. Pro ukonceni nahrdvani staCi v ptipad€ pure Screengrabbing-u jedno jediné dalsi

stisknuti tla¢itka se symbolem monitoru (Screengrabbing: Start).

Po ukonceni nahrdvani dojde ke zobrazeni dialogu slouZiciho k zaddni metadat. Pro
predstavu si feknéme, Ze polozka Title bude pouZita napfiklad pii organizovani sbirek
prezentaci v LECTURNITY Publisheru, k vytvdfeni automatickych symbolickych
odkazli a slova uvedend v sekci Keywords pomohou v LECTURNITY Playeru pii
vyhleddvani nahravek s poZadovanym obsahem. Polozky Author a Creator jsou ryze

informativniho charakteru.

5.3.11 Co dal

Seznamil jsem vds se zplsobem pofizeni LRD-souboru (nahravky), kterou miiZete
pro kontrolu dile prehrdt v LECTURNITY Player-u, upravovat v LECTURNITY
Editoru a prfevadét do video-formatii v LECTURNITY Publisher-u.
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6 LECTURNITY Editor

Editor umoZiuje dodateCnou editaci a optimalizaci hotovych nahrivek. Editace
nahrdvek spo€iva v odstrafiovani hluchych pasazi, pfipojovani jinych LRD-soubort,
v importu a exportu audio-stop nebo videi. PouZiti editoru nenf vZdy bezpodminené

potieba.

6.1 Spusténi Editoru

Po dokon¢eni nahravky v LECTURNITY Assistant-u a jejim vybéru my3i jde Editor
oteviit z kontextového menu v okné Recording History nebo tlaCitkem Edit v tomtéZ
okné. Mimo Assistant 1ze Editor spustit z nabidky Start nebo pomoci zastupce programu

na plose.

Pro otevieni nahravky v prostiedi LECTURNITY Editoru vyberte v menu polozku
FileO pern (implicitné uréené k otvirani *.lep), Filelm port nebo stisknéte standardni
klavesovou zkratku Ctrl+O. Po objeveni otviracitho dialogu vyhledejte, vyberte a

oteviete pozadovany LRD-soubor.

Otevieni nahravky v Editoru je umozZnéno také vybérem volby Edit z kontextového

menu Windows Exploreru.

6.2 Prostredi Editoru

V Editoru jsou dokumenty zobrazoviny podobnym zplisobem jako v Assistant-u
nebo Player-u. Snimky jsou piedvadény v Presentation Area. Struktura dokumentu
(Document Structure, snimky, klipy a kapitoly) je vidét v piehledu umisténém v levém

hornim rohu obrazovky.

Ve video-oblasti je zobrazovano doprovodné video nebo obrazek. Bezprostiedné pod
tiemi zminénymi oblastmi se nachazi tzv. Stream view. Ve Stream view jsou k nalezeni
viechny multimedialni komponenty nahrdvky (video, klipy, snimky, hlasovd slozka
nahrdvky) rozprostiené podél Casové osy zplsobem, ktery odpovida poradi jejich
postupného spousténi. Stream view umoZiiuje navigaci v dokumentu s pfesnosti na

milisekundy. Piesnd navigace napomdihd provddéni pozZadovanych dprav za pomoci
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ndstroji z Toolbar-u nebo akei vybranych v menu. Toolbar v Editoru predstavuje lista
umisténd pod oblasti Stream view. Funkci tlacitek prozrazuje QuickInfo (klasicky, Zluty
informacni rdmecek). Provedené zmény je mozno vracet stiskem Crri+Z nebo opakovat

pomoci Ctri+Y. Stejny efekt maji volby Edir-> U ndo resp. Edit-> R edo.

“ My Pressniatios - Editor
Dl [ Jnewt Yme Corbml Cirme ¢
Wy Presernain =

LEC! Document structure [SM1AY90 Presentation area

Dummy Lid.
w
The Road, Bd. 111
19134 Tho Trun'S pmeshen
VideorStill image |- '
O T

W, UMMMy, com

Can Dummy

Siream view Timeline

CutiCopy/Paste

T

D CFEE) N CFE T

Slide navigation Mark Undo/Redo Zoom

6.3 Lecturnity Editor Project

Vsechny operace, zmény a nastaveni provedend béhem prace v Editoru jsou
zapisovany do souboru s pfiponou LEP (LECTURNITY Editor Project). Projekt
provazi uZivatele béhem celé prace v prostiedi Editoru pocinaje nactenim jedné nebo
vice zdrojovych nahrdvek a konle exportem vysledného LRD-souboru. V piipadé
nutnosti je mozné nedokonceny projekt ulozit do LEP-souboru a pozdé€;ji na rozdélanou
praci navdzat. Pro uloZeni projektu vyberte v menu File-> Save as. Ve zobrazeném
dialogu vyberte adresai. NapiSte jméno projektu a potvrdte uloZeni. VSechny zmény
jsou uloZeny vramci LEP-projektu a origindlni zdrojovd data (klipy, videa, LRD-

soubory) ziistdvaji nedotCena ve stavu v jakém byla sama naposledy uloZena.
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6.4 Modifikace nahravek

Pfi pofizovani zvukovych nahrdvek dochdzi Cas od cCasu prefeknutim nebo
nezddoucim pomlkdm. Za pomoci grafického zobrazeni zvukového zdznamu, které se
nachdazi v sekci Stream view, jde podobné nedostatky nalézt, vybrat a odstranit. Postup je

ndsledujici:

1. Spustte prehravan{ projektu z Toolbar-u stiskem tlacitka Srart.

(... FERER)

2. Po nalezeni ¢asti, kterou si prejete odstranit, zastavte prehravani tlacitkem Stop

nebo stiskem mezerniku.

[~ _ . s ~
{ 0:00:0353 J J I! |Slarl3 the preview [Space]E’

3. Nyni vyberte oblast, kterd se vim nezamlouvd. K tcelu pfesné lokalizace hranic
vybéru pomaha funkce Zoom in, jejiz ikona je k dispozici na Toolbar-u. Zoom in
zvétSuje pohled na grafickou interpretaci zvukového zdznamu. Samotny vybér je
mozné provést tazenim mysSi se stisknutym levym tlac¢itkem a kurzorem v oblasti

Stream view nebo vymezenim oblasti zna¢kami pro zacatek a konec vybéru.

( y w |Sels the right mark. [_E]I

Jestlize chcete vybrat celou ¢ast nahravky piisluSejici ur€itému snimku nebo klipu
potom klepnéte ve Stream view na zvoleny objekt pravym tladitkem a v kontextovém
menu vyberte polozku Mark Slide nebo Mark Clip. Provedeni téZe operace za vyuZiti
menu Editoru, pfedpoklddd umisténi ukazatele aktudlni pozice ve Stream view na

zvoleny snimek/klip a naslednou volbu Edit-> Cur rent Slide/Current Clip-> Mar k.

Vybrand oblast je ve vSech pfipadech zvyraznéna vySednutim barvy jejiho pozadi.
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Pro pfehrdni vybéru zvolte v menu Control-> Selection-> Replay Selection nebo

stisknéte kombinaci kldves Crri+mezernik.

4. KdyZz si piejete oznafenou Cast z nahravky odstranit, pouZijte tlacitko Cur
umisténé na Toolbar-u nebo vyuZijte klavesové zkratky Coi+X.
V LECTURNITY Editoru. Tim dojde k vymazani v3ech komponent leZicich
v oznalené Casové oblasti. Neni tedy moiné odstranit napiiklad pouze video a

zvukovou sloZzku vybrané ¢asti nahravky v projektu ponechat.

Pokud si piejete vybranou pasaz do nahravky(resp. LEP-projektu) znovu vloZit,
potom na Casové ose naleznéte a ukazatelem oznacte jejf novou pozici a na Toolbar-u

stisknéte tlaCitko Paste. VloZeni vybéru zajisti stejné dobfe klavesova zkratka Ceri+ V.

6.5 Vkladani nahravek

Vkladani nahrdvek (LRD-soubord) do projektu aktudlné otevieného v
LECTURNITY Editoru je uzitené ke spojovani tématicky souvisejicich nahrdvek
vzniklych vriznych ¢asech nezdvisle na sob& Pro zminéné kombinovini oteviete
v Editoru jednu z nahravek, které zamyslite pouZit a v menu zvolte fnsert-> Recording
Document (LRD). Dile vyberte kam chcete dalsi z nahrdvek vloZit. Nabizi se moZnosti
vloZeni na zaCatek projektu, konec projektu nebo vloZeni na aktudlni pozici ukazatele na
casové ose. Po uréeni mista vloZzeni nahravky zbyva uZ pouze samotny vybér nahravky
za pomoci dialogového okna, které se automaticky objevi. Popsanym zplisobem miiZete

vlozit/propojit libovolné mnoZstvi LRD-soubord.
6.6 Vkladdni klipi a videi

Vrdmei dprav projektu je moiné do n& v Editoru vklddat videa nebo
Screengrabbing-ové klipy. Postup je jednoduchy:

1. Na ¢asové ose vyberte pozici pro vloZeni klipu.

2. V menu Editoru vyhledejte volbu InsertCl ip a upiesnéte zda si piejete vloZit
video (From Video File} nebo Screengrabbing-ovy Kklip(From Recording
Document). V piipad€ obou voleb nasleduje vyb&r dokumentu v dialogovém

okné.
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Vybrané video/klip bude vloZeno na difve specifikovanou pozici v otevieném

projektu.

Pokud uZivatel vybere v dialogovém okné€ pro vloZeni klipu nahravku (LRD-soubor)
s vice klipy, potom dojde k vlozeni pouze prvniho ze vSech klipli v nahrdvce

obsazenych.

Drobné komplikace mohou nastat v piipadé, kdyZ je pod vkladanym klipem nahrany
zvuk. UZivatel je vtakovém okamZiku vyzvén, prostiednictvim dialogu Clip audio
track, k tomu aby programu sdélil zda si preje zvukovou slozku klipu pouZit popiipadé
jakym zptisobem ma byt pouZita. Zvukovy doprovod klipu miize zcela piekryt a nahradit
ptvodni zvuk. Oba zvuky mohou byt mixovany (tj. slouCeny a prehravany naraz). Klip,
véetné zvukové slozky, 1ze do nahrdvky také vsunout. Pii vsunuti klipu do nahravky

budou vSechny zvuky zachovény.

Clip audio track . X

7? The given clip file also containg an audio stream. Do you want to
- import the audio stream, too?

If yes, what do you want to do?

[Mix with existing audio zl

audio
Insert audio [document lengthens)

V piipadé, Ze je vloZeny klip ve formdtu jehoZ export neni podporovin (WMYV,
MPEG), LECTURNITY Editor nabidne uZivateli pfednastaveny pievod do vyhovujictho

formy.
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6.7 Premistovani klipu

Pro piipad, Ze uzivatel vloZi klip do LEP-projektu na nespravné misto, obsahuje
Editor moznost zmény pozice klipu v projektu. Pokud chcete pfesun provést, najedte
nad vybrany klip ve Stream view ukazatelem mySi. Stisknéte a drzte levé tlacitko mysi.
Pri stisknutém levém tla¢itku vyvold pohyb mysi taZeni (tj. zm&€nu pozice) klipu podél
Casové osy. Po uvolnéni levého tlacitka bude klip vloZen na misto kde se aktudlné

nachazi ukazatel mysi (resp. polohy).

0:00:05,00 0:00:10,00 0:000:15,00 0:00:20,00 0:00:25,0¢

stilmage2.avi

Vramci projektu lze sklipem, za pomoci jeho chyceni a taZeni (Drag&Drop),
pohybovat pouze v mezich urenych koncem piedchdzejiciho a zafatkem nasledujictho

klipu. Znamen4 to, Ze timto zptisobem neni mozné ménit pofadi klipd v projektu.

6.8 Zména titulku u snimki a klipi

Miize se stit, ze po dokonCeni nahravky uZivatel objevi rozpor mezi obsahem
snimku/klipu a jeho jménem(7irle). Tato nekorespondence se objevuje zejména u
Screengrabbing-ovych klip(, kterym jsou automaticky pfifazovana jména ve tvaru Clip
n, kde n je pofadové Cislo klipu v projektu. Jména tohoto typu zjevné nemaji zadnou

vypovidaci hodnotu a proto je Zadouci je zménit.

Zménu jde vyvolat z kontextového menu, které se ve Stream view objevi po kliknut{
pravého tla¢itka mySi na klip/snimek, ktery ma byt pfejmenovan. V kontextovém menu
je kdispozici polozka Title and Keywords. Po vybéru zminéné poloZzky je zobrazen
dialog s jehoZ pomoci jde upravit titulek a klicové slova(Title, Keywords) piisluSejici

upravovanému snimku/klipu.
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x

Metadata I

Title:
o

Kewwords [separated by :):

| 0K I Stomao Fouzit Napovéda

Volba Title and Keywords je dosaZitelna také z menu. Pouziti menu predpoklada

pfedchozi umisténi ukazatele pozice ve Stream view na klip/snimek, ktery mame
v timyslu upravovat. Po ur€enf pozice zbyva vybrat v menu Edit-> Cur rent Slide/Clip

-> Title and Keywords.

6.9 Vkladdni a zména klicovych slov

Kli¢ova slova jde piifadit bud’ nahrdvce jako celku, jednotlivym snimktim nahravky
nebo napifklad klipim. Pfi pozd€j§im prehrdvini LRD- a LPD-soubori
v LECTURNITY Player-u jde klicovd slova vyhleddvat a tim je pifmo vyuZzit k nalezen{
urCitého tématu. Zapsand kliCovd slova jsou dile pouzita pifi tvorb€ dokumentl
odpovidajicich standardu (souboru norem) SCORM (viz. dile). Prvni moZnost piipojeni
klicovych slov k nahravce se uzivateli naskytd v LECTURNITY Assistant-u po

e

zajiSfuje LECTURNITY Editor.

Pro zménu kliCovych slov piisluSejicich nahrdvce jako celku, vyberte v menu
poloZku FileE xport and Preview Settings. V dialogu, ktery touto volbou vyvolate,
vyberte zalozku Matadata a do piislusného pole zapiSte kliova slova odd€lend od sebe

sttedniky. Zmény potvrdte stiskem tlacitka OK.
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Pfi zadavani kliCovych slov ndleZejicich ke konkrétnim snimkim se vyuZiva
kontextového menu vyvolaného jednoduchym kliknutim pravého tlacitka mysi na oblast
piislulejici ve Stream view vybranému snimku. V menu vyberte vyse zminénou polozku
Title and Keywords. V dialogovém okné provedte zamyslené zmény. KliCova slova
nezapomeiite oddélovat stiednikem. Zmény potvrdite a dialog opustite stiskem tladitka

OK.

Stejné jako v piipadé zmény titulkd snimkd a klipd jde pro dpravu kli¢ovych slov

vyuzit menu. Postup viz. vyse.
6.10 Pripojovdni doprovodnych obrdzki

Nahravka (LRD-soubor) miize obsahovat privé jeden doprovodny obrizek (Srll
Image==tichy obrazek) nebo video. Pfifazeni doprovodného obrazku (napi. fotografie)
se projevi pifi piehravani LRD- resp. LPD-souboru. Okno LECTURNITY Player-u je
v oblasti pro zobrazeni aktudlniho snimku rozdéleno do dvou &asti. V levé Casti je
umistén obrazek a v &4sti pravé jsou promitany snimky. Pomér velikosti obou ¢asti jde
meénit a podle volby zobrazeni je také mozné sledovat bud vyhradné obrizek nebo
jenom snimky. Pro pfipojeni obrazku k nahravce vyberte z menu volbu Insers-> Still
Image. V dialogovém okné€ naleznéte soubor s obridzkem, ktery si pifejete pfipojit.
Vyberte jej a vybér potvrdte. Pfipojované obrazky sméji byt ve formatu GIF, IPG nebo
JPEG.

Pro vymazéani doprovodného obrazku zvolte v menu EditR emove Still Image.
6.11 Pripojovani doprovodnych videil

Na mist€¢ doprovodného obrizku se miize nachdzet také video. K vloZeni videa
vyvolejte z menu dialog volbou File-> Video-> Import from video file. V piipadg, Ze
vklddané video ma také zvukovou sloZku, budete dotdzani jestli si ji piejete pouZit. Pfi
tomto vybéru se nenabiz{ volba smiSeni plivodni zvukové sloZky nahravky se zvukem,

ktery je soucasti videa. Ze zvuki je nutné si jeden vybrat s tim, Ze druhy bude potlacen.
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6.12 Import a Export Audiosouboru

Zvukovou Cast editované nahravky (LRD-souboru) 1ze exportovat (tj. uloZit) ve forme
zvukového WAV-souboru. Tato moZnost se hodi zejména pfi poZadavku editace
nahrivky audio-ndastroji, které nejsou v Editoru k dispozici. Ve specidlnim programu
ur¢eném k modifikaci audio-soubori (napf. Audacity, doporucuji} jde zvukovou
nahrivku upravit a obohatit o celou fadu efektli a po provedenych tpravich ji
importovat zpét do matefského projektu. Pro export zvukové asti projektu do WAV-
souboru vyberte z menu poloZku File-> Audio-> Export As WAV... Nasledné dojde ke
zobrazeni dialogu, ktery vas provede uklidanim souboru. Po uloZeni WAV-souboru
provedte planované dpravy. Po skonfeni a uloZeni Gprav pokracujte v praci v editoru
volbou File-> Audio-> Import from audio file... V dialogu naleznéte upravené WAV-
soubory a kliknéte na tlaCitko Open. Import WAV-souboru vyvola nahrazeni plvodni

zvukové slozky nahravky obsahem vlozeného souboru.

6.13 Nastaveni moZnosti Exportu

V dialogu vyvolaném z menu File-> Export and Preview Settings se nachizi fada
voleb pro nastaveni vlastnosti Exportu projektu nebo jeho vybranych &asti. Nékterd
z téchto nastaveni jsou vyuZita také pii piehravdni LRD-soubord v okné Editoru
(Preview). K nastavenim platnym spole¢né pro export a piehrdvani soubort patii
napiiklad rozliSeni nebo hlasitost. K dpraveé zminénych nastaveni oteviete vy3ie zminény
dialog. Vyberte si jednu ze zobrazenych zéloiek Video, Audio, Metadata, pop¥. Clip.

Provedte potfebné zmeény a potvrdte je jednim z tladitek OK nebo Pouzit.

Dialog Export and Preview Settings je dosaZitelny také z kontextového menu ve
Stream view. VyuZiti kontextového menu poskytuje moZnost pfifadit niznym

multimedialnim prvkim projektu rozdilnd nastaveni.

Na kart€é se ziloZkou Video jdou uréit vlastnosti vloZzeného doprovodného
videosnimku. Tato nastaveni nemaji vliv na klipy, které jsou soucésti projektu. UZivatel
ma moznost uréit rozlideni doprovodného videa. Implicitné piednastaveni hodnota
odpovida rozlideni ve kterém bylo video pofizeno. Kazdd zména v rozlifeni vede

k poklesu kvality zobrazeni videa. Napravo od poli¢ek definujicich horizontalni a

vertikdIni rozliSeni videa se nachazi check-box s popiskou Keep aspect ratio. Zatrzeni
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této volby zajiSfuje pouzivani implicitniho rozliSeni doprovodného videa, popiipadé
zachovani poméru stran videa pfi zméné€ jednoho rozmert.

Export settings x|

Video |Audi-:- | Metadata| Clips |

— Yideo size and framerate:;

Videa size: 120 " |220 [V Keep aspect ratio

Offset: I 0 ms
Framerate: I 15,000 fpz Reset |

— Codec zettings
Codec: | 32); Inkel Indeo(R) Video R3.2 ~|
Lonfigure |nformation
Quality: _} 75%
Keyframes: v Use keyframes

I'l ] Frames between kepframes Default |

[ Smart Recompression

| oK I Stomo Pouzit Népovéda

Pokud pochézi obrazova a zvukova slozka videa z rliznych zafizeni (napf. videokarta
a zvukovd karta) pak se mohou vyskytnout chyby v synchronizaci obou soucasti.
V takovém piipade je mozné pfifadit obrazové sloZce tzv. Offser. Offset zplisobi podle
potieby bud zpoZzdéni nebo predbihéni, zkratka Casovy posun, obrazu vzhledem ke

zvuku.

O poctu obrazovek (resp. rdmcti) zobrazenych za jednu sekundu béhem promitdni
doprovodného videa informuje policko Framerate. Implicitni nastaveni je urceno
rychlosti promitani, kterd je vloZzenému klipu vlastni. Ackoli je moZné Framerate menit,
obecné se to nedoporucuje. Zména frekvence promitdni snimki vede ke sniZeni kvality

videa.
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Na zilozce video je dale k nalezeni prostor vé€novany nastaveni Codec-i. Volba
Codec-u fikd jakym zplsobem bude doprovodné video komprimovino a v jakém
formatu bude uloZeno. Piednastavend volba obvykle odpovida typu doprovodného videa.

ray

Zména Codec-u ptinasi snizeni kvality videa. V§jimku tvoii bezztratové kodovani.

Explicitng jde upravit také kvalita pfehrdvani. Implicitni nastaveni obsahuje
origindlni kvalitu sjakou je pfipojena video-nahrivka pofizena. Nastaveni sniZené
kvality piehrdvdni se projevi poklesem kvality obrazu, ktery je do jisté miry

kompenzovan zmensenim velikosti vysledné nahravky.

Keyframes jsou specidlni rimce (resp. obrazovky), které urychluji vizudlni navigaci,
tj. fizeni zmény polohy, vramci konkrétniho video-snimku. Pokud se rozhodnete
Keyframes vyuiit, zatrhnéte na kart€ volbu Use kevframes a urcete pocet snimki, které
maji byt vlozeny mezi tyto specidlni rimce. Cenou za zrychleni je ndrtst velikosti

vysledné nahravky.

Posledni volba na zdloZce Video je check-box s popiskou Smart Recompresion.
Zatrzeni téhle moZnosti vede k tomu, Z¢ zména rozliSeni a kddovini videa bude
aplikovdna pouze na ty jeho ¢asti, které byly upraveny. Zbytek videa z{istiva nezménén.

Volba Smart Recompresion tak urychluje export nahravky.

Na ziloZce Audio jsou soustiedéna nastaveni pro zvukovou sloZku nahrivky. Tato

nastaveni se netykaji zvukového doprovodu vloZzenych video-klipd.

Sample rate uruje pocet audio-vzorkll, které maji byt v exportované nahrivce
piehrany za jednu sekundu. Implicitni nastaveni se shoduje s origindlnim poctem vzorkl
audio-sloZzky exportované nahravky. SniZen{ Sample rare-u zplsobi pokles kvality

zvuku a zvyseni poctu vzorki nema Zidny efekt.

Sample size tik4 v kolika bitech bude po exportu binarné kédovana skuteénd hodnota
intenzity zvuku. Pfednastaveny pocet bitli odpovidd kédovani origindlu. SniZeni poctu
bitd znamena pokles kvality zvuku a zvySeni poftu bitd nepiind3i zaznamenatelné

zlepsSeni.
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Zalozka Metadata skryvd doprovodné informace k projektu. Mezi témito
informacemi nalezneme polozky Title, Author, Creator a Keywords. Zminéné informace
jsou i soucdstmi kone¢nych produktd vytvofenych v LECTURNITY (napf. *.Ipd,
* html, atp.). PoloZky Title a Author jsou zobrazovany béhem piehrdvani vSech cilovych
formdtd a ostatni informace lze zpravidla urlitym zplisobem vyvolat. Metadata jsou

pouzitelnd také v souborech podporujicich standard SCORM.

Export settings I x|

Video | Audio  Metadata | Clips |

Title:
I'v'elblnud

Authar:
ILukaZ

Producer:
ILukaZ

Keywords [separated by ;]:
Ibloud

Codepage: 1250

Jestlize je do projektu vlozeny alespoinl jeden klip, potom pfibude v nabidce Export
settings zdlozka Clip. BliZ8i specifikaci klipu, jehoZ nastavenf si piejete ménit, provedte
vybérem z menu Clip. Misto uloZeni zdrojového videa/klipu je zapsidno v policku

Source.

Uréeni rozliSen{ klipu a rychlosti jeho pfehrdvani (Clip size and framerate) se navlas

shoduje se stejnou ¢4sti nataveni doprovodného videa.

Nastaveni Codec-u je doplnéno tlacitkem Apply for all Clips. Vyznam je ziejmy.

Nastaveny Codec bude pouZit pro viechny klipy v projektu.

Hlasitost klipu Ize zménit posuvnym ukazatelem, nadepsanym Volume clip. Volba

Volume present sound je urCena ke zméné hlasitosti zvukového doprovodu snimku
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v oblasti ve které je vloZeny klip spolu se svym zvukovym doprovodem. Zvukova
nastaveni je moZno akceptovat pro viechny klipy vloZzené do projektu. Staéi pro to

stisknout tlacitko Apply for all Clips.

6.14 Export projektu nebo jeho Cdsti

Po dokon¢eni vsech dprav v projektu je nutné vysledek exportovat. Export je
uskute¢nén skrze vytvofeni nového LRD-souboru. Zdanlivé neopodstatnéné plytvani
mistem v podobé vytvaieni novych a novych soubori md sviij divod ve snaze zachovat
diléi vysledky pro moznost pozdé€j$itho pouZiti. Novy LRD-soubor je zpravidla dale
vyuZit k vytvoieni cilového produktu/souboru za vyuZitit LECTURNITY Publisheru.
Samotny export je moZno vyvolat z menu File-> FExport...nebo kldvesovou zkratkou
Crrl+E. V dialogu, ktery je timto vyvolan, se doporucuje vytvofit novou slozku a teprve
do nové sloZky ulozit vyslednou nahravku. Tato opatrnost zamezi piepisu doprovodnych
datovych souborii, ke kterému by s nejvétsi pravdépodobnosti doslo v pfipadé ukladani

vice nahrdvek do jednoho adresare.

Pokud chcete ve vysledku prezentovat pouze vybér z projektu pak nejprve oznacte
v editoru oblast, kterou si pfejete exportovat. Nasledné vyberte v menu poloZku File->
Export selection...nebo stisknéte kombinaci klaves Shift+Ctri+E. Poté se objevi zndmy
dialog. Vyberte/vytvoite adresdi. Zvolte jméno nahravky. A vie potvrdte stiskem

tlacitka Save.

Exportem do LRD-souboru kon¢i price s LECTURNITY Editorem. Dal3i operace
s nahravkou zabezpecuje LECTURNITY Publisher.
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7 LECTURNITY Publisher

LECTURNITY Publisher se od vétSiny soucasti baliku LECTURNITY odliSuje
svym prostfedim. Po otevieni Publisher-u je spusténa posloupnost navazujicich dialogi
podobnych Kklasickému windows-ovému privodci instalaci programu.  Publisher
provede postupné uZivatele celym procesem prevodu hotové LRD-nahrdvky na cilovy

medidlni soubor vybraného formatu.

7.1 Okno prvni - Na co?

Bezprostiedné po otevieni Publisher-u, pfed vlastn{ praci, je uzZivateli ukazano okno,
které ho prostiednictvim ,basic computer english® seznami s tim, k Cemu je program

uréeny. Press Nexr in order to continue.

7.2 Okno druhé — Vybér LRD

Po stisku tladitka Next je uZivatel v novém okné vyzvan k nalezeni LRD-souboru,
ktery si pfeje publikovat. Umisténi souboru jde programu sdélit bud postaru zapsanim
cesty a jména souboru do pfisludného pole a nebo novéji a pohodingji nalezenim
souboru v dialogovém okné vyvolaném stiskem tlagitka Browse... Pokracujte stisknutim

tladitka Next.

7.3 Okno tfeti - Formadat

Ve tietim okné je na uZivateli zvolit jeden ze Ctyf na vybér nabizenych vystupnich
forméth. K dispozici jsou formity RealMedia document, Windows Media document,
Flash document (with Macromedia flash) a domaci LECTURNITY Presentation
Document. Pro porovnani charakteristik jednotlivych formatil jsou vybrané vlastnosti
zobrazeny v ¢asti okna nadepsané Properties. V Properties jde napiiklad zjistit zda je
piisludny formét uréeny pro publikovani na internetu nebo jestli a v jaké mife format
vyhovuje souboru norem SCORM. Tladitko Advanced rozsifuje moZnosti nastaveni
pievodu o specifikaci zptsobu prace s videem. DalSi popis plati za piedpokladu, Ze

zvoleny vystupni format je LPD-soubor. PokraCujte stisknutim tlacitka Nexz.
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7.4 Okno Ctvrté - Zvuk

Ctvrté okno nabizi volbu 3ifky zvukového pasma, tj. kvality zvukového doprovodu,
vysledného multimedidlniho dokumentu. UZivatel m4 vybér ze dvou poloZek 48Kbps a
256Kbps. Podle doprovodného komentdre plné postacuje mensi z obou Sifek pasma.
VeEtsi Sitka padsma sice piinese drobné zlepSeni kvality zvuku, avSak zaroven s tim si

uloZeni takového zvuku vyz4da pétkrat vice mista. Pokradujte stisknutim tladitka Nexz.

7.5 Okno paté - Dodatky

Dodatecnd nastaveni jako tieba zplisob spousténi (napif. Fullscreen) exportovaného
dokumentu miizeme provést v patém dialogovém okné. Pro piipad nejasnosti tykajicich
s¢ moznosti nabizenych nastaveni je vlevé dolni Casti patého dialogového okna

pomocné tlacitko Help. Pokracujte stisknutim tlacitka Next.

7.6 Okno Sesté - Zmenseniny

Pokud si jako vysledny formdt pro svou praci zvolitt LECTURNITY Player
Document, potom budete v Sestém okné vyzvani k zaddni rozméru miniatur snimki
(Thumbnail). Takto vytvofené zmenSeniny jsou v LECTURNITY Player-u zobrazovany
v oblasti Document Structure (viz. vySe) a slouZi ke zpiehlednéni pohybu a navigace
v dokumentu. V okné je nutné vybrat alespofi jednu ze tif velikosti Small, Medium,

Large. Implicitn€ jsou zatrZeny vsechny tii volby.
7.7 Okno sedmé — Kam s tim?

Sedmé okno je nadepsano Target selection a ve shodé€ s nadpisem je v ném uzivatel
pozadan o specifikaci cilového adresdie do néhoZ ma byt uloZen vysledny soubor.
Zptsoby urceni cilového adresare jsou opét dva. Cestu do adresaie lze bud ru¢né napsat
do piipraveného pole, nebo jde adresaf vyhledat v Open File Dialog-u, ktery vyvolad
tlacitko Browse. V tomtéz okné se nalézd check-box s popisem Inregrate into a CD-
collection. Vyb&rem této moZnosti zajistite zaClenéni vysledného LPD-souboru do

vybraného CD-obrazu (viz kapitola CD-Publisher).
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7.8 Okno osmé - Info

V osmém okné je piehled informaci o zdrojovém a cilovém souboru vietné fady
uZivatelem provedenych voleb. V piipadé€, Ze si piejete nékterou z vlastnosti zménit, pak
mizete vyuzit tlalitka <Previous, které ddva moZnost ndvratu do pfedchazejicich oken.
Tlagitko <Previous je souCasti viech oken vyjma prvniho z nich. Pokud jste se
zobrazenymi souhrnymi informacemi srozumeéni a spokojeni, ukonéete prevod stiskem

tlacitka Finish.

7.9 Okno devaté - Prevod

Tlacitko Finish odstartuje samotnou konverzi. Objevi se nové okno. UZivateli je
ponechdna pouze volba potlaceni (tj. zruseni) celého probihajiciho procesu. Konverzi je
mozno zastavit stiskem tlacitka Cancel(==Storno). Cely proces konverze LRD-souboru
do vysledného formatu je dosti zdlouhavy a proto je velice vitané textové informovani o
pribéhu pievodu. Na samotny zavér bezchybné provedeného pievodu se objevi
informaéni okno s napisem ,,Conversion finished succesfully™ a nezbyva nez vytvofeny

dokument spustit.

7.10 Ostatni formdty

Od tiettho okna byl popisovdn pouze zplisob pifevodu LRD-souboru do
LECTURNITY Player Document-u. Dialogy pro publikaci v ostatnich podporovanych
formétech se od sebe navzdjem velice siln€ odliSuji. Nebudeme se jimi podrobné a
jednotlivé zabyvat. Clov&ku se zdkladni (resp. mirn& pokro€ilou) znalost{ angli¢tiny by

nemela orientace v dialozich ¢init vétsi problémy.

Spoleénym znakem vsech nabizenych formitd, s vyjimkou LPD-soubor, je alespoii
¢astecnd podpora skupiny norem SCORM. Plnou podporu (akceptovaniy SCORM-u
poskytuje ze vSech nabizenych formati pouze Flash document. Protoze se SCORM
stdle vice, siln€ji a Castéji prosazuje, podivejme se na to jak vznikl, co nabizi, jaké

standardy SCORM-u pfedchdzely a které skupiny je vytvarely.
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7.11 NORMY

V souasnosti se pfi hlubSim zijmu o e-learning neni mozZné vyhnout nékolika
zkratkdm zna¢icim spolednosti, které se zabyvaji vyvojem norem pro e-learning.
'Nejstar$i’ skupina pravidel pro vystavbu e-learning-ovych produkti byla vyhotovena pii
tvorb& vyukovych lekei pro lidi pracujici v leteckém primyslu. Zkratkou komise
zaStifujici tento poCin je AICC (The Aviation Industry Coputer Based Training

Committee). Tato spole¢nost si kladla tii zdkladni cile:

1. Pomoci leteckym spoleénostem s vyvojem smérnic tykajicich se v¢inné a

ekonomicky unosné aplikace vypocetni techniky pfi tréninku zaméstnancu

2. Vyvinout smérnice zajiSfujici vyuZitelnost e-learning-u ve vice primyslovych

oborech

3. Vytvofit prostor pro otevienou diskusi o technologiich vyuZitelnych pro e-
learning. Smeérnice produkované komisi AICC nesou oznadeni AGR (AICC
Guidelines&Recommendations) a piestoZe dnes uz nema AICC hlavni slovo pii

ur¢ovani standard pro e-learning, tak se na jeho podobé stile velmi silné podili.

V soudasnosti nejpouzivangjdi skupina pravidel ma zkratku SCORM (Sharable
Content Object Reference Model) a byla vytvofena spole¢nosti ADL (Advanced
Distributed Learning). Spole¢nost ADL byla zaloiena v roce 1997 americkym
Ministerstvem Obrany a Kancelafi Bilého Domu pro Védu a Technologické patenty.
ADL spolupracuje s daldimi védeckymi organizacemi a institucemi na dosaZeni
optimélnitho vyuZiti existujicich technickych norem a specifikaci, které se tykaji vyuZiti
inf. technologii ve vyuce. Mezi Organizace spolupracujici s ADL na dosaZeni
zminéného cile patii napf.: Insitute of Electrical & Electronics Engeneers(IEEE), the
Aviation Industry CBT Committee(AICC) nebo Alince of Remote Instructional
Authoring & Distribution Networks for Europe(ARIADNE).
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SCORM je orientovany na vyuZiti internetovych technologii. Specifikace a

doporuceni, kterd tvofi SCORM, jsou rozdéleny do ¢tyiech skupin (knih). Skupiny jsou:

1. Uvod do SCORMu obsahuje konceptudlni informace, historii v§voje. aktualni

stav SCORMU a nastinéni sméru dal3itho vyvoje.

2. Cast o &lenéni obsahu popisuje prostiedky pro vystavbu vyukovych materiilé a

zabyva se téZ Clenénim a prenositelnost! vysledku mezi niznymi systémy.

3. SCORM Run-Time Enviroment je oddil tykajici se fizeni vyukového systému

(Learning Managment System == LMS).

4. Posledni kniha nese ozna¢eni the SCORM Sequenting & Navigation a zabyva se
tim, po jakych ¢astech bude obsah prezentace uZivateli pfedkladan a nakolik

bude moZné priibéh vyukové lekce uZivatelsky ovliviiovat.

Vyvoj SCORM-u neustile pokratuje. Jeho nynéjSi verze nese oznaeni SCORM
2004 a ADL je rozhodnuto ponechat uréitou dobu tento balik bez zmén, aby tak vznikl

prostor k jeho rozdifeni do praxe.

ADL poskytuje zdarma nékolik programii slouzicich ke kontrole dodrZeni norem,

které jsou sou¢asti SCORM-u.

To, zda program podporuje SCORM, je moZné provéfit s pouZitim programu
SCORM Conformance Test Suite. Tuto aplikaci mohou vyuzit bud vyrobci softwaru pro

test svych produkti, nebo autofi e-learning-ovych lekei ke kontrole obsahu svych dilek.

SCORM Meta-Data Generator Tools slouzi k vytvareni(resp. vkladani) meta-dat do
projektli. Tim zajistuje ¢lenéni obsahu do kapitol a pfipojovani kli¢ovych slov. SCORM
Meta-Data Generator Tools byval autory softwaru zapracovavan do prostiedi pro tvorbu

e-learning-u, ale v sou¢asné dob& ADL naddle nepokraCuje v jeho vyvoji.

51



8 LECTURNITY CD Publisher

LECTURNITY CD Publisher je nistroj ur€eny k automatickému vytvaieni obrazi
CD nebo DVD. Necekejte ale Zadné *.iso . Vytvofeny obraz ma formu kolekce LPD-
soubori doplnénych o nezbytné administrativn{ informace typu HTML-obsahu s odkazy
nebo napi. autorun-u. Soucasti kolekce publikované na CD mohou byt volitelné také
programy ur¢ené k piehravani LPD-soubori. Pfitomnost piehravach na CD osvobozuje
uZivatele od povinnosti instalace LECTURNITY Player-u. LDP-soubory jsou v takovém
piipadé spoustény piimo z CD.

8.1 Start CD Publisher-u

ZacClenéni souboru do kolekce je mozno zajistit uz v LECTURNITY Publisher-u
béhem pievodu LRD-dokumentu na LPD-soubor. Pro zatfazeni do kolekce sta¢i v okné
oznaCeném Targer selection vybrat prevadény dokument a zatrhnout check-box
s popiskou Integrate into @ CD collection. Po \ispésném vytvofeni LPD-souboru dojde

k automatickému otevieni CD Publisher-u.

Steyné jako viechny ostatni sou¢asti LECTURNITY jde CD Publisher kdykoli oteviit

také s vyuzitim nabidky Start nebo zastupce programu na plose.

Samotny CD Publisher md s LECTURNITY Publisher-em kromé jména podobnou
také formu. Price se CD Publisher-em je tak fadou dialogi postupné vyzyvajicich

uZivatele k provadén{ potfebnych operaci.
8.2 Okno prvni - Zprava Projektu

Informace o kolekcich urfenych k publikaci na CD-nosi¢ich jsou uchovaviny
v projektech. Prace s CD Publisher-em proto za¢ind zaloZenim nového nebo otevienim
existujictho LECTURNITY CD Project-u. Pro dalsi popis pfedpoklidejme zaloZeni
nového projektu. Vytvofeni nového projektu piislusi volba Create new CD project. Pro

pokraCovani stisknéte tladitko Nexr>.
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8.3 Okno druhé — pojmenovdni projektu

Po zaloZeni projektu nasleduje piechod do nového okna, ve kterém je vyZadano
jméno a misto(cesta) pro uloZeni projektu. K nalezen{ adresafe do néhoz ma byt projekt

ulozen, doporuduji vyuZit tlacitko Browse.
8.4 Okno treti — Nastaveni projektu

Ve tfetim okné je piitomna volba k uréeni cilového adresife pro uloZeni soubord,
které budou soucasti CD kolekce. Jinymi slovy to znamend, Ze se ma vybrat sloZzka do

které umistime obraz CD.

V tomtéz okn€ najdeme dva check-boxy urujici zplsob prehrivani LPD-souborii
obsaZzenych v nastavované kolekci. Volba Replay from CD without Player installation
zajisti vySe zminéné piehrdvani z CD zatimco v piipadé€ vybéru polozky Replay from
CD with Plaver installation bude samotnému piehravani pfedchizet instalace

LECTURNITY Player-u na disk.

Tlagitko Extended... spousti okno s pokro¢ilymi nastavenimi zplsobu prace s paméti

cache.

Pokracujte stiskem tlacitka Nexr>. V piipadé, Ze se objevi dialog, ktery si Zada
potvrzeni zaloZeni nového adresdie pro uloZeni obrazu CD, pokracujte stiskem tlacitka

Yes.

8.5 Okno cétvrté — Volba LPD

V dvodu kapitoly jsme si poved&li, Ze zdkladem kolekce jsou LPD-soubory. Ctvrté
okno CD Publisher-u je mistem na kterém LPD-soubory vybirame a nasledné vkladame
do projektu.

Pro pfidani souboru do projektu stali stisknout tlacitko Add, dany soubor nalézt
v zobrazeném okné a oteviit jej. K odstranéni vybraného souboru z projektu se v okné
naléza tlacitko Remove. Zménu pofadi souborli v projektu jde provadét tlacitky Up,

Down. Zminéné potadi se odraz{ v posloupnosti odkazii na soubory v HTML-obsahu.
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8.6 Okno paté - Vzhled obsahu

V patém okné stoji uZivatel pfed tkolem ur€it jak bude vypadat HTML-obsah celé
kolekce. Na vybér je pét moZnosti. SnaZii cestou je volba jedné ze Ctyf
pieddefinovanych Sablon. Pon€kud obtizn&jsi je definice vlastniho vzhledu obsahu.
Piesny popis postupu k vytvofeni vlastniho obsahu je uveden v anglickém manudlu
k LECTURNITY. Prosti iprava HTML-kédu hotového obsahu nardzi na specificky
zpusob, kterym LECTURNITY stranky formatuje. Takhle jednoduse to prosté nejde.

Pii vyhleddvani $ablon pomizZe tlacitko Browse. PokraCujte stiskem klavesy Finish.

8.7 Okno Sesté — Tvorba obrazu

Tlacitko Finish ukonCuje nastavovani vlastnosti obrazu CD a zahajuje jeho vlastni
vytvafeni. V Sestém okné je uZivatel graficky informovan o plnéni jim zadanych 1ikoli.
Proces je mozno pferusit stiskem tladitka Cancel. O vysledku provadénych Cinnosti je
uZivatel zpraven prostiednictvim informa¢niho okna. Po usp€3ném vytvoieni kolekce jde

tato ze zobrazeného okna spustit tla¢itkem Stars.

Pro dpravu hotovych kolekci zvolte v prvnim okné CD Publisher-u poloZku Opern an
existing CD project a vyberte projekt, ktery si piejete modifikovat. VSechna nasledujici

okna se plné shoduji s témi, ktera byla popsédna vyse.
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9 LECTURNITY Player

Program LECTURNITY Player(pfehrdva¢) slouzi k pfehravani dokumenti
vytvofenych v LECTURNITY Assistant-u(*.LRD) nebo v LECTURNITY Publisher-u
(*.LPD). Piimo z Assistant-u a z Publisher-u jde na vybranych mistech LECTURNITY
Player také spustit. Standardni cestou k otevieni pfehrdvace je vyuZiti menu Start, nebo
double-click na zastupce umisténého na pracovni ploSe. Ke spuSténi prehrivace vede
taktéZ bud dvoj-klik na LRD- resp. LPD-soubor nebo vybér volby Replay
v kontextovém menu Exploreru vyvolaném kliknutim pravého tla¢itka mySi na ikonu

naleZejici souboru pfislusného typu.
9.1 Prostiedi LECTURNITY Player-u

Ve své zakladni podobé ma prostfedi piehravace podobu klasického

celoobrazovkového okna rozd€leného do né€kolika oblasti. Délenf okna Player-u ukazuje

obrazek.
¥ LukaZ: velbloud - Player — O] x|
File “iew Control Extras ?
Thumbnails Searchl
velbloud Presenation area
0:00 Document structure
Piikladek, JO 7 i | \\ [— 2
oo () privsiag. 10 3} ety
; — vl NA : -

= W prikladu buderme poiat velblouddm moby (77 )

Plikladek, JO ?

= Abychom se vyhnuli problémiim, nem powfita diakritiba .

0:07
Clip
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V horni ¢asti okna piehrdvafe se nachazi pro OS s okny viceméné typické menu
jehoz prostfednictvim jde otevirat soubory, ménit zptsob pohledu na piehrdavany
dokument, fidit pfehrdvani (start/stop, jump), upravovat nastaveni pfehrdvace nebo

spoustét napoveédu.

O prostor pod menu se déli oblasti Presentation area a Document Structure popt.
jeste Video/Still image. Vlastni ptehrdvani probihd v Presentation area. V sekci
Document Structure jsou obvykle k vidéni dv€ zdlozky. Prvni znich je zdlozka
Thumbnails, na které jsou statické miniatury symbolizujici jednotlivé pododdily
dokumentu spjaté zpravidla dobou vzniku a zdroveil piislusnosti ke stejnému snimku (v
*.1sd). Miniatury jsou pro piehlednost opatfeny popisem, ktery je vytvofen z titulkd
podkladovych snimkl. Druhd zdlozka nese na Stit€ nadpis Search a je urfena pro
vyhleddvani nadpist (7itle), kliCovych slov (Keywords) nebo prosté Casti textu (Full

Text) obsazenych v dokumentu.

V prostoru s oznacenim Video/Still image je vyhrazeno misto ur¢ené pro doprovodné

video.

Pfi dolnim okraji okna LECTURNITY Player-u je umistény Toolbar s tlacitky

uréenymi k fizeni priib€hu piehrdvani. Vzhled Toolbar-u ukazuje pfilozeny obrizek

Time display Slider || Time line -

o

S popisky.

¢ Replay/Pause

’} : m Full Scresn ?] Video | E] Thwrmknail
N i |
Navigation Volume Mute Player Display

Prevazna vétsina ndstrojli zobrazenych na Toolbar-u jsou standardni ovladaci prvky,
které je moZno potkat v celé fadé multimedidlnich pfehrdvadi. Re& je o tla&itcich pro
start/stop a navigaci v nahravce, o display-i ukazujicim uplynuly ¢as nahravky, o Casové
ose a o jezdci pro regulaci hlasitosti. Za drobnou odliSnost od standardu 1ze povazovat

oblast Player display s jejiz pomoci jde urovat na jak velké video (mySlena obrazova
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Cast prehrdvaného multimedidlniho souboru) se budeme divat. Kliknuti na ikonu
Fullscreen piepne piehravani do celoobrazovkového reZimu. Ikona Thumbnail skryje
Document Structure (volitelné i doprovodné video) a obrazova ¢ast nahridvky zaujme
takovou €ast zbylého prostoru, kterd ji dovoli zachovat si pomér stran a zaroveti pokryt
maximalni moZnou plochu. Ikona Video je aktivni pouze tehdy pokud je
k nahravce/dokumentu pfipojen doprovodny obrazek nebo video. Pfipojeny obrizek
vyplni po kliknuti na ikonu cely prostor mezi menu a Ioolbarem zatimco v piipadé
piipojeni videa vyvold tatiz akce pouhé zobrazeni (resp. skryti) oblasti Video/Still

image.
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10 Zavér

Vysledkem prace jsou mé nové nabyté zkuSenosti s ovlidddnim prostiedi
LECTURNITY, které jsou formou nivodu pro dalsi uZivatele-tviirce uvedeny v této
knize. Dal$im podstatnym vysledkem je multimedidlni kurz pro vyklad a vyuku
programovaciho jazyka C. Tyto lekce jsem poskytl kolegim i ¢lenim katedry
softwarového inZenyrstvi.
Vzhledem ke zpé&tné vazbé, které se mi od okoli dostalo pfevazné ve formé€ pozitivnich
ohlasti, usuzuji, Ze jsem dosdahl splnéni v&tSiny cild, které jsem si vytyCil. Netvrdim, Ze
jsem nemohl dosdhnout lep$ich vysledka.
Pii vypracovavani teoretické ¢4sti se mi oteviela fada novych obzorii a sezndmil jsem se
s n€kolika softwarovymi produkty, které si zaslouzi byt ve spojitosti s e-learningem
zminény jako urCité alternativy k predstavenému LECTURNITY. Upozornénim na

‘konkurenéni” programy si pfeji ukdzat na dvé skute€nosti.

Za prvé, téméf vidy existuje moznost volby. S trochou nadsiazky si dovolim tvrdit, Ze
kdyz se vzdime drobnych funk¢nich libiistek a nebudeme pozZadovat zaruky, pak je
docela dobfe moZné ziskat legdlné a zadarmo prakticky stejny software, jaky je
renomovanymi firmami nabizen za cenu v fadech desitek tisic korun. Na druhou stranu
chépu, Ze napiiklad pro firmy se tento piistup nehodi. Zhrouceni dileZitych programi
nebo nezajisténé pokracovani ve vyvoji takto ziskanych aplikaci, mizZe ve firmé vyvolat
vainé obtize a tak je z hlediska podniku vyhodné&jdi pfiplatit si a v piipadé problému
poZadovat jistou nahradu.

Za druh€ je jisté, ze vzdy si jde vybrat lep3i nebo horsi alternativu. Ani u e-learningu
tomu neni jinak. Z tohoto pohledu se mi LECTURNITY jevi jako produkt patiici
kvalitativné do ‘stfedni tfidy’ software-u spojeného s e-learningem . Tato pozice je, dle
mého nazoru, vyvoldna zejména tim, Ze se jedna o relativn€ novy (perspektivni) produkt

bez delsi tradice.

Na konec zdvéru opakuji skute¢nost, Ze existuje nespocet poZadavkil a spousta zplisobl
jakymi je lze splnit. Ve spojitosti s rostoucimi multimedidlnimi moZnostmi prostych
prezentaci upozoriiuji na OpenSource-ovy program OpenOffice.org Impress. Z
komerénich produkti si jist€ zaslouZi pozornost napi. programy inzerované na

internetovych strankéach [3].
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Citace/Zdroje

Béhem sestavovani této prace jsem Cerpal informace pievazné ze zdroji nalezenych
na internetu. NiZze uvedené adresy byly pIné platné a funkéni v prvnim a druhém
Ctvrtleti roku 2006. Za trvajici platnost adres se nemohu nikterak zarudit, ale domnivam
se, Zze ohledem na postaveni organizaci a firem, které jsou provozovateli doporucenych

stranek, se nenf tfeba obdvat jejich zaniku nebo neobjasnitelného zmizeni.

V piipadé elektronickych zdroji se mi nepodafilo nalézt doprovodné informace jakymi

jsou jméno autora, datum vzniku, atp.

[1] www.aicc.org - strdanky organizace AICC

[2] www.adlnet.org

[3] www.e-learn.cz - Ceské strdnky spolecnosti zabyvajici se e-learningem
[4] www.e-learningguru.com

[5] www.knowledgepresenter.com

[6] www.elearningeuropa.info

offline zdroje:
[7] LECTURNITY 1.7 Manual — elektronicky manudl k programu

[8] Karel Capek, HOVORY S T.G. MASARYKEM, 1937
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